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1.2

Introduction

The software, 3D DataManager, consists of two modules. The first, 3D DataManager
Extractor, is designed to export a SmartPlant 3D database into a Microsoft Access
file, containing one table per task. The resulting records are compressed and internally
resolved by code lists. The Access file serves as a base for the second module, the 3D
DataManager user interface, used to create Reports with simple drag ’n drop opera-
tions.

Additionally, 3D DataManager is divided into two versions. The 3D DataManager
Reporter utility is primarily used for reporting, while the other version, the 3D Data-
Manager Pro Extends the Reporter version with the ability to change Data and write
the changes back to Intergraph’s SmartPlant® 3D

General Conventions

This document contains many visual cues to help you understand the meaning of certain
words or phrases. The use of different fonts for different types of information allows
you to scan the document for key concepts or commands. Symbols help abbreviate and
identify commonly used words, phrases, or groups of related information

Typefaces

Italic Indicates a system response, which is an explanation of
what the software is doing. For example,

The text is placed in the viewing plane.

Bold Indicates a command name, parameter name, or dialog
box title. Command paths are shown using an arrow be-
tween command names. For example,

Choose File > Open to load a new file.

Sans serif Indicates a system prompt or message, which requires an
action be taken by the user. For example,

Select first segment of alignment

Normal typewriter
Indicates an actual file or directory name. For example,

The ASCII report is stored in the layout. rpt file.

Bold typewriter
Indicates what you literally type in. For example,

Key inoriginal .dat to load the ASCII file.
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1.3  Symbols

This document uses the following symbols to identify special information:

= | Note — important supplemental information.
+ Map or path — shows you how to get to a specific command or form.

@ More information — indicates there is additional or related information.
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2 Installation

Requirements:

« Operating system: Windows 2000 SP4/XP/2003/Vista
« Intergraph SmartPlant 3D SP4 (7.0.0.44.10) or later
« Microsoft Excel 2000 or later (only for 3D DataManager Reporter)



License

License

There are two different licenses:

. 3D DataManager Reporter: used to extract SmartPlant 3D plant into
access in order to make reports

. 3D DataManager Pro: Extends the 3D DataManager Reporter features
as listed above, and enables the write changes function, which transfers
changes made to values in the interface back into SmartPlant 3D

Once the setup has been completed, and the program is started, a license key will be re-
quested, as shown below.

DEMO Version g|
Your cument domain name
SPaD7
License key
[ QK ] [ Cancel ]

=l Note: Without a valid license the software works in demo mode.

= Note: As seen above the domain name is required in order to generate a
license key. 3D DataManager can then be used with the same license key
on all computers in the same domain.

If the installed license needs to be updated (i.e. evaluation license) select Update li-
cense... from the Help menu. The dialog box shown above will be displayed again.

-
lsm About... =

Tasks Taslk fiter
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4.1

3D DataManager Extractor

= | Note: 3D DataManager Extractor requires SmartPlant 3D and a Smart-
Plant 3D (S3D) license seat on a SmartPlant License Server.

The 3D DataManager Extractor is used to extract SmartPlant 3D data out of an ex-
isting project. Since the extractor uses the SmartPlant 3D API, it requires SmartPlant
3D and a SmartPlant 3D License seat (S3D) on a SmartPlant License server. Using
the API enables the extractor to be installed and used without dealing with any issues
from the Database.

Loading and Setting up a SmartPlant 3D Plant

Use the Plant combo box to select a SmartPlant 3D plant.

Plart

Madison w

PDS_SP3D
testhersich

After selecting a Plant, the available Tasks and the associated filters are displayed in the
Tasks section. Use the tree in the filter section to apply a filter to the selected task.

= | Note: Applying the filter will speed up the extraction process

Tazkz Fiping filker
Electrical - na filter
Equiprment - na filker Py Filters
HWAL - no filker +|- Platit Filters

Fipirig - nio filker
[ ] Piping Catalog - [0 pipe specs)
Structural - no filker

The Equipment-, Piping-, Electrical-, HVAC- and Structural-tasks includes all task-
specific data from the plant. The available filters are defined via SmartPlant 3D.
If checked, the catalog task will extract all the Piping specific data from the catalog to
the specified database, during the extraction.

Tazkz Piping Catalog filker
Elzctrical - na filker = [ |Pipe Specs A
Equipment - no filker 1C0031
HWAL - no filker 1Cm a0
Fiping - nio filker []1coiom
Piping Catalog - [2 pipe specs) []153977
Structural - no filker []153984

[ 22 v

= Note: For each task individual filters can be applied.
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4.2

= | Note: Extracting the Catalog with all available specs selected may
lengthen the extraction duration. Keep the Pipe Specs selection to a bare
minimum in order to shorten the extraction time

Browse with the ([:]) button to create a Microsoft Access Database file where the re-
sults will be created.

Aocess databaze
[ u::"-.temp;xS.F'.EDT rair.mdb E]

[] Force estraction [ Eutract I [ E xit I

Force extraction — By default the software processes only changed objects since the
last extraction when the switch is disabled (recommended).The data of the last extrac-
tion is stored in *.3dm file which is password protected and located in the same direc-
tory as result access database. If the *.3dm file doesn’t exist or the force extraction
switch is enabled, all objects will be extracted from SmartPlant 3D this can require a
large amount of time.

Create SmartPlant Review session- See Create SmartPlant Review session

All the settings are stored automatically in the configuration file which is found under
Tools>Settings.

Start the process by clicking the Extract button.

= | Note: The progress bar displayed at the bottom right hand side of the
window does not display the true progress. It displays the progress for each
object in SmartPlant 3D. due to this it will load multiple times.

Create SmartPlant Review session

3D DataManager Extractor allows creation of a Design Review session which can be
viewed in 3D DataManager or in SmartPlant Review.

If the checkbox Create SmartPlant Review session is enabled the software creates
SmartPlant Review *.vue file containing the graphical objects from selected tasks (ac-
cording to the applied filter) and the SmartPlant Review database (*.mdb2) with at-
tributes as configured in the “Configure attributes” menu

= Note: *.vue file can be opened in SmartPlant Review 6.2 or higher.

= | Note: The *.xml file containing attributes for SmartPlant Review ses-
sions, which is typically created upon creation of a SmartPlant Review in
SmartPlant 3D, is not required and not generated, because all attributes for
the objects inside of the *.vue file is stored directly in the SmartPlant Re-
view database (*.mdb2).
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4.3

4.4

Configure Search Filters

The search filters menu allows defining SmartPlant 3D filters which will be used to
check if they contain any of extracted objects. As result the software creates a table
named “Object Filters” in resulting access database which has the following format:

Item Name Filter Name
Concentric Size Change-0001 Complete Plant
Concentric Size Change-0001 Areal
Tee-0001 Complete Plant

= | Note: The table shown above demonstrates a concept only. The resulting
database contains the object OID column instead of the Item Name. Any of
the attributes for the corresponding object can be queried by joining the
“Object Filters” with the proper table (e.g. “Piping” or “Equipment”).

= | Note: Selecting many search filters may cause low extraction perform-
ance.

Configure Columns/Attributes

The ability to configure attributes is specifically made in order to configure and add user
attributes to the next extraction.

The appearance of the columns in the resulting database can be configured by selecting
Configure attributes... from the Tools menu. The following dialog will be shown:

Awailable attibutes Ised attibutes
#- Electrical = Equipment ]
=F Fquipment +- Area System —
+- Area System +- Construction Requirement
+- Equipment +- Construction Type
+- Equipment Component - Dry CG X
+- Equipment System - Dy CGY
+- Pipe Nozzle - Dry CG £
+- Smart Equipment Part +- Dry Weight
£ Unit System +- Dry Weight Unit Type
£ WBS tem +- EBnd Preparation
+- WBS Project +- Bnd Standard
H- HVAC +- Bquipment Name
+- Piping +- Bquipment Position X
+- Piping Catalog +- Bquipment Position Y "
+- Structural +- Bquipment Position £
[ 0K | | cancsl
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The tree on the right hand side shows the configured columns in a specific task (table).
The Objects listed on the left hand side are used as references for the column mapping
which is done on the right hand side.

Mapping one or more objects to columns can be done by dragging and dropping a se-
lected object in to the target column.

If you expand the column node in the right tree, you will see the object variants, the
column cells can contain.

Ised attributes

=I- Piping -
¥ Area System
+- Bend Angle
= Commodity Class

+l- Bolt Part

+- Gasket Part

+- Pipe Suppart

+- Pipe Weld

+- Pipe_Component

Commodity Sub Class

Commodity Type

Date Last Modified

Design Maximum Pressure

Design Maximum Pressure Unit Type

Design Maximum Temperature

Design Maximum Temperature Unit Type

Design Minimum Pressure

Ne=sion Minimom Preszire Lnik Tvne ot

oy O O oy O O oy O O O

In the last expansion level the attribute name is listed as shown below.

Ised attributes
=l Piping ~
1 Area System
1 Bend Angle
= Commodity Class
—I- Bolt Part
=I- |JBolt
Bolt Type
Gasket Part
=I- lJGashet
(Gasket Categony
Fipe Suppart
=I- Constants
MLILL
Fipe Weld
=I- Weld
Class
= Pipe_Component
=I- LINPineComnonent

Different attributes can be mapped to a single column as shown above. The attribute that
fits to the object type in the current row will be shown. A single column can be removed
or renamed by selecting the necessary option in the context menu which is opened by
right clicking on a node. The attributes which belong to an object type are listed by ex-
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panding the relative object type node. Dragging a single attribute node and dropping it
on the (task/table) main node on the right side will map the object to the column.

= | Note: The changes will be applied on the next extraction

4.5  Configure Units of Measure

Select Configure Units ... from the Tools menu to customize the UoM (Units of Meas-
ure) settings for the result database. The units of measure are taken for SmartPlant 3D.
They directly affect the results of the extraction, since each value is calculated using the
set unit type in the grid. For example, a length of a 1000 mm would display 1m in the
result database if the distance Unit Type is set to meters.

{'.r onfigure Units E@E

Init Type it Decimal Precision  Leading Zero Trailing Zeros |
p amount of substan | mol Ll
angle deg
angular acceleratio | deg/s™2
angular momenty  |kg-m"2/s
angular velocity  |degls

ares mm"2
body force Niem™3
coeflicient of therm |/C
density kglem™3
distance i

dynamic viscosity |Pa-s
electric charge C

_._._._._._._._._._.G_.
EEEEEEEEEEEE
FREEREEEEEEEE

(]
=
o
1
o
=
13
.

« Unit Type — Unit of Measure description
« Unit — Measuring unit abbreviation

« Decimal Precision — Decimal precision to format the value (decimal
count)

« Leading Zero - Enable leading zero to format the value
« Trailing Zeros —Enable trailing zeros to format the value

= | Note: The changes will be applied on the next extraction

4.6 Result database

The software creates separate tables, with one row per object, for each selected task.

10
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Chjects Create table in Design view
] Tables EI_J Create table by using wizard
_.fi:_l Queries EI_J Create table by entering data
| Equipment
= F
- E=
i3 Reports | Piging
%5 Pages E  Piping Catalog
=2 Macros = Plant
H  structural
¢ Modules

Sample reports and queries are also included in the created Access file.

Objects |E|_=J Create query in Design view
=1 Tables E‘_J Create query by using wizard
= ) _E',=.| Biolts
I_;-IQE _E',=.| EQP Mozzle
= Forms _E',=.| Equiprment Material Take-OFF
i Reports _E',=.| Equipment Mozzle Sorted by Mozzle Mame
Y4 Pages 5 Item Coordinates
2 Macros = Pipe List
_-f',=.| Pipe Total Length Sorked by MPD
Wi Modules _E'|=.| Pipelines Sorted by Mame
Groups _E',=.| Piping Material Take-OFF
3] Favorites _E',=.| Piping Specification Report (Long)
_E',=.| Piping Specification Report (Shaork)

Piping Catalog
The table contains the following objects:

« PipingCommodityFilter
. BoltSelectionFilter

« GasketSelectionFilter

« NutSelectionFilter

« WasherSelectionFilter

Piping
The table contains the following objects:

« Pipe Part

Pipe Component
« Implied Part Occurrence
« Pipe Instrument

1
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« Pipe Specialty Item
. Pipe Bolt Set

« Pipe Weld

« Pipe Gasket

« Pipe Supports

=! Note: The length, surface area and Volume are estimated values that are calculated using ba-
sic mathematical formulas. These values are only estimates and should only be used as a
reference.

Equipment

The Equipment table contains one row for each nozzle and one additional row for each
Equipment/Equipment Component without any nozzles as shown below:

Equipment Equipment Component Nozzle
Pump N1
Pump N2
Tank Ladder

Tank Platform

Tank N1
Tank N2
Tank N3
Loudspeaker

The table contains the following objects:

. Equipment
« Equipment Component
« Pipe Nozzle

Structural
The table contains the following objects:

« Member Part Prismatic
« Member Part Curve

. Ladder

. Stair

12
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« Handrail

« Assembly Connection
. Footing Component

. Slab

HVAC

The table contains the following object:

« Duct Component

Electrical

The table contains the following objects:

. Cable Tray Component
. Cable Tray Part
. Cableway

Plant

The table includes the information about the plant and database.

4.7 Batch Mode

The 3D DataManager Extractor can be use in to ways. The conventional way, which
has been described up to this point, and a somewhat less conventional way, using a
command line as seen below. This function can be used to help automate the exportation
of a SmartPlant 3D Plant.

Opening the command window is done by clicking the windows start menu, and select-
ing the run item. Then enter cmd into the text box. This will open the prompt.

To then open the 3D DataManager Extractor batch mode help type in the installation
path of 3D DataManager followed by “\3D DataManager Extractor.exe”
/?.

G >"CisProgram FileswCAXpertss3D DataManager~3D DataManager Extractor.exe' -7

3D DataManager Extractor.exe' splant plant_name [Aconfig config file.inil

splant plant_name — SmartPlant 3D plant to process
seonfig config _file.ini — Config file

There are two parameters for the 3D DataManager Extractor. The first is the Smart-
Plant 3D plant name. The other is a configuration file which contains the settings for
the extraction. If a configuration file is not defined, the last selected configuration will
be used.

13
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5 3D DataManager Reporter

3D DataManager creates queries and easy-to-customize reports based on the Access
file which contains the SmartPlant 3D data, exported using 3D DataManager Extrac-
tor. The user interface is made in such a way that simple drag ’n drop operations can
quickly create, save and export custom reports. On top of all the listed functions, the 3D
DataManager Pro version additionally allows changes to the data in SmartPlant 3D.

5.1

A Brief Overview

The Reporter window is separated into four sections as follows:

Views

qon 30 DataManager, Pro - C:\Documents and SettingsidministratoriDeskiopiMadison.mdhb

Parts of 3D DataManager
= | Note: All sections can be resized and the visibility can be toggled. To
show or hide a single section use the appropriate buttons ( [LE|JE | i ), re-

size can be done by moving the bars between the sec (') and/or by resizing

Elements

the window.

File  Tools  Window  Help
P a0 ) s R ElE]E]
HewYiew
ER E quipment ;8 0 g 319 Recards
+- Piping = Dy Weightl Dy weightf End Preparation End Standard Equipment I #
Piping Catal
—FLLLEES L, +- [¢] End Preparation
+-[¥] End Standard hd AC100
+- [¥/] Equipment N ame AL-200
+- [¥] Mazzle Mame : G-2
= Mozzle Place Paint 3 Raised-face flange  Default B-004
+ Miz=le Place Point Raized-face flange  Default B-004
= Mozzle Place Paint Z Raized-face flange  Drefault B-004
+[7] Mpd Raigedface flange  Default B-004
- Mpd Unit Type Raized-face flange  Default B-004
+- [7] Part Description Raised-face flange  Default B-004
5 [#] Part Mumber Raized-face flange  Default B-004
= Prassure Fating Raized-face flange  Drefault B-004
Quantity Raized-face flange  Default D100
+ Quantity Unit Type Raized-face flange  Default p-100
= % chedule Thicknass Raized-face flange | Default D-100
Raized-face flange  Default D100
Raized-face flange  Default D-100
Raized-face flange  Default D100
Raized-face flange  Default D100
Raized-face flange | Default D-100
Raized-face flange  Default D100
Raizrd-fare flanne Tefanlt M-1nn b
>
Tree Filter Report Attributes Report Grid

As seen in the figure under A Brief Overview, 3D DataManager consists of three main
parts. Each part performs its on specific function in order to give the best control over
3D DataManager. The following sections describe the each part and function briefly.

15
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Tree Filter

16

+- Equipment ——
- Piping — |
+- Area System
=- Commodity Type
+- AL —  Attribute Modes
45 deqgree elbow, lang radiuz
-I- Area System
Sulphur Recaoven Area -
[Itility Area
A0 degree elbow  ———  “alue Modes
90 deqgree elbow, lang radiuz —
Ball walve shart pattern

Tazk Modes

+

+

+

Nodes of the tree view

The Tree Filter is a visualisation of the SmartPlant 3D Database, exported with 3D
DataManager Extractor to an Access Database (see: Working with 3D DataManager
Extractor). Each node listed in the Tree Filter is either a table, column or value repre-
sented in the Access Database, which in retrospect refer to a task, attribute or value in
SmartPlant 3D.

As seen in the above figure, the base nodes are always Task nodes. These Nodes repre-
sent each table in the Access Databank, and can be added, or removed with the Tree
Manager (see Tree Manager). Task nodes cannot be renamed.

The second node types visible are the Attribute nodes. These nodes can be differentiated
from the value nodes by bold text and from the task nodes by position. Attribute nodes
are always at the even positions in the tree path. Unlike Value nodes and Table nodes,
these nodes can be renamed (see Context Menus).

The last type of nodes listed in the figure are Value nodes. These represent each possible
value for an attribute, and are used as a filter and grouping mechanism for a View (see
Grouping Tree Elements).
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Report Attributes
- T
R |
Commodi Toe Path Attribute ”~
=[] Area System Mon-Mumeric Cperation
COUMT Selected Attr.

+ D ate Last Modified

= Design Maximum Pressure hlumeric Operation

Selected Attr.
[] b=
D MIN — Cperations
SIM
[ ] COUNT
+)- [ Diesign M awimum Temperature
- [_| Dezign Minimum Prezzure Attributes
+)- [ ] Diesign Minimum T emperature )
. Operation Selected
+-[ ] Drp Weight
. . Collapzed Attr.
- [ ] First Size Schedule "

Attribute Statuses

The Report Attributes lists all available attributes for the selected task in the Tree Fil-
ter (see Tree Filter). Checking or un-checking an attribute adds/removes a column to the
Report Grid (see Report Grid and Arranging Views) while checking Operators adds
columns that have influence on its related attributes values.

There are four Operators:

MAX - calculates the maximum value for each row in the Report Grid. This Opera-
tion cannot be selected with its corresponding attribute.

MIN - calculates the minimum value for each row in the Report Grid. This Operation
cannot be selected with its corresponding attribute.

SUM - calculates the sum of all values in each row in the Report Grid. This is the only
value that can be selected with its parent attribute, as it won’t create misleading results.

COUNT - displays the number of unique values of the parent attribute for each row in
the Report Grid. This operation cannot be selected with its corresponding attribute.

Attributes are divided into three types, numeric and date, non-numeric, and Path Attrib-
utes. The operators that are allowed are for each attribute is determined by the type of
attribute. Numeric attributes have all Operators unless the attribute is also in the path,
then it only has a sum. Non-numeric attributes only enable COUNT operations. Attrib-
utes with checked operators are shown in bold print.

Path Attributes are shown in italics. They refer to attributes that are in the current path
of the selected node in the Tree Filter, and are used to group and/or filter in the Report
Grid. Path Attributes cannot be un-checked, instead have to be unselected in the Tree
Filter.

17
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Report Grid
30 Records

Fart Murmber Part Dezcription [uantity Quantity Unit Tepe SUR_of_Dryweig #

¢ CESVMVeszel2Platt  |Simbervessel 3 B.0|pcs 44400
ComplesHarizontal | ComHorColYeszel 3.0|pcs 0.0
E20584zm 2.0/ pcs
ElecEnclosure 423 | Type 1 Electncal E 11.0) pos 4686
ElecEnclozuredsam 1.0|pcs
ElectricalPendantd |H7 - LIGHTIMG, P 10.0) pos 0.0
HCPumpl4 3"«2"-  |Honzontal Centrifu 14.0) pos 74760
HCPumpD5 8"«4"-  |Honzontal Centrifu 120 pos E408.0
Heat Exchanger 5 [Shell & Tube Heat 2.0|pcs 1480.0
Heat Exchanger 5 [Shell & Tube Heat B.0|pcs 44400
HorShellTubeExc  |Honzontal Shell & 28.0 pos 0.0
HorShellT ubeE s 18.0 pos
Horizontallrum 01 |Honzontal Crum wi 28.0 pos 207200
HorizantalD rumés 370 pos
FettleHeatE xchan 120 pos
Loading_Cock Loading Cock 1.0|pcs 300.0
FURMP 001A_[MP- | Centrifugal Pummp, 24.0 pos 17760.0
FURMP O01AM-E Centrfugal Purmp, 2.0|pcs 1480.0
Receptaclel1-E Electrical Recepta 2.0|pcs 0.0
SimpleterCylE gpl 4.0|pcs b

Report Grid

The Report Grid Displays the Data that is selected by the two other components, the
Tree Filter and the Report Attributes, in a standard table format. All columns shown

are created from the selections in the Report Attributes.

The Report Grid has three types of columns, which are similar to the Report Attribute
columns, the Path Column, the Operator Column and the Attribute Column. Each type

of column is created by selecting a certain type of node in the Report Attributes.

Path columns are shown in italics and if they have a value selected in the Tree Filters
are not filterable. Filters can be applied to all other columns, and other functions such as

sorting can be done in this view (see Grid Functions).

Menus and Toolbar

There are a wide variety of toolbars and Menus in 3D DataManager The following will

show a brief explanation of those and where to find them.

Main Menu

The menu bar contains four drop-down menus as follows:

18

« File — Open Project, Load/Save Views

. Tools — Tree Manager (configure visibility of nodes in the tree), Settings

« View - change the visibility of sections or toolbars
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« Help - open this 3D DataManager help, update the licence or open the
About box

Toolbar Buttons
The Toolbar allows faster access to the most important functions from the menu.
7 - Add a new view.
I - Opens an existing view.
“d - Saves current view.
1 - Close the selected view.
s - Export the report currently shown in the grid into a Microsoft Excel worksheet.
i= - Adds all attributes available to for the selected node.
= - Removes all attributes below the selected node.
- Shows or Hides the Tree Filter.

L7
1 - Shows or Hides the Report Attributes section.
1B

- Shows or Hides the Report Grid.

Context Menus

There are four Context Menus, one for each section of 3D DataManager. The Menus
are opened by right clicking on the associated item. All functions which are in each re-
lated menu can be found in the Menu bar and/or as a toolbar button. The different
Menus are as follows:

View Context Menu

The View Menu is opened by right clicking on a View Tab. Possible operations
are as follows:

_:ﬁ Save Wiew

Save Yiew s,

7 Close View

Save View — Saves the current selected View. If the selected View has not been
saved before, opens the Save As dialog.

Save View As — Saves the View under a certain file name.
Close View — Closes the selected View

=l Note: There must be one View at all times, the last view cannot be
closed.
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Node Context Menu

For each node in the Tree Filter a context menu can be opened by clicking the right
mouse button.

Rename

Reset Rename

Add attribute 3

Add all atkributes

Remove akkribute

Rename — Renames the target Attribute Node. This is only visible with attribute nodes.

Reset Rename — Sets the Attribute node name back to the original name. This is only
visible with attribute nodes.

Add attribute — Opens a popup menu listing all un-added attributes. Selecting one adds
it to the selected node.

Add all attributes — Add all available attributes to the selected node

Remove attribute — Removes the selected node representing an attribute. This is only
visible with attribute nodes.

Remove all attributes — Remove all attributes assigned under the selected node. . This
is visible for all non-attribute nodes.

= | Note: Many context menu actions can be done with mouse actions such
as Drag ‘n Drop or clicks

Attribute Context Menu

The Attribute Context Menu is opened by right clicking the Report Attributes.
Actions available are as follows:

Select Al

)
8
|
o Unselect Al

Select All — Selects all attribute nodes
Unselect All — unselects all attribute nodes, including operator nodes.
= | Note: Unselecting will not affect the path nodes

Grid Context Menu

The Context menu shown below is the first and primary way to filter. Right click on a
cell in the grid to open it.
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5.2

1 Filter by Selection

Exclude Seleckion

Append Exclude Selection
Operational Filkers 3
Append Operational Filkers 3

Clear Column Filter

o

G Clear all Filkers

Filter by Selection — Sets the column filter to the current value in the selected grid cell.

Exclude Selection — Sets the current column filter to exclude the value in the selected
grid cell.

Append Exclude Selection — Excludes the current value in addition to the current
value(s) in the filter. This option is only enabled if the column has been filtered by ex-
clusion.

Operational Filters — these filters are only available for numeric and date/time col-
umns. The popup menu contains filters for ‘Greater than’, ‘Less than’, ‘Greater than or
equal to’, and “Less than or equal to’, all are relative to the current selected grid cell.

Append Operational filters — These Filters are only available for numerical or
date/time columns and if a previous operational filter has been set in the current column.
This option enables the possibility to filter for values between two values.

Clear Column Filter — clears the current column filter in which the selected grid cell
resides.

Clear All Filters — Resets all the filters in the grid. With the exception of filters set in
path columns (see Report Grid)

It is also possible to filter by selecting an item from the filter combo box at the top of
each column (see Filtering)

Status bar and Log

The status bar at the bottom of the Window Displays the current actions made in the
program. Double clicking on it will open the log in which all actions and errors are
saved.

The Log File can be found under the Temp directory on the current computer under the
3D DataManager folder.

Views

Views are saved program states and are visible as tabs above the tree, attributes and grid
(see below).
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Fipe Part Mewview [E1' MewView(?] B3

+- Equipment g 1 |
+- Piping

+- Piping Catalog > Err-.ydﬁvgza:;tiun

End Standard
Equiprent Mame
Mozzle Mame

Mozzle Place Point %
Mozzle Place Paint Y
Mozzle Place Point £

+
+
+
+
+
+
+
+
+

JEREFEEEEREE

=
=)
(=

Opening a View can be done in two ways, first, in the file menu, and secondly with the
toolbar button (I==). Multiple Views can be opened at the same time. Each view is dis-
played as a tab a seen above.

Creating a new view can be done just as easily, this also has a menu item in the File
menu, and a toolbar button( =).

Closing a View is done with the same methods as listed above and additionally with a
context menu which is opened by right clicking a tab. The toolbar button icon is"™*1.

Views also have the Save (“d), Save As (&), and the Save All function, which can be
found in one or more of the above mentioned Menu or toolbars. Saving writes changes
to a view into a 3D DataManager View File (.cvf). After saving, this file can be opened
with any Project.

= | Note: When opening a view, make sure, that the project used to open it
has the required tasks and attributes. Otherwise 3D DataManager will not
open the view.

Opening a Project

When 3D DataManager is opened for the first time, the open project dialog will appear.
Select a Microsoft Access database file previously created with 3D DataManager Ex-
tractor in the dialog to load it. This project will be opened automatically on the fol-
lowing start. To open a different project, select the Open project... option from the File
menu.

= Note: It is possible to disable the automatic opening of the last project in
the settings, under the tools menu.

Customizing the Tree Filter

Select Tree Manager ... from the Tools menu. The following dialog box appears.
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Mat Visible sible
(M| Equipment | ] Equipmert
[] Piping [linfa
=[] Piping Cataleg [JPiping
[] End Preparation 3 [ Piping Catalog
[[] Engineering Tag
[] First Size To
[ Materal Grade
[[]Object Type
[] Pri Size NPD Units
[[] Reportable Commedity Code
[15ec Size NPD Units
[ Second Size Units
[]Short Code
[15pec Name
[ Plant
[ Structural

=
=

Dont Show Attributes without Values ’ OK ” Cancel l

Expanding a task node will list all available attribute nodes. Select the required attrib-

utes by checking the preceding checkbox. Press the Add button () to add the se-

lected nodes to the visible Report Attributes. Click on the button to remove se-
lected attributes from the left tree, after selecting them. Press the OK button to apply the
changes. The Don’t Show Attributes without Values check box enables or disables at-
tributes under all Task Nodes which have no values in the database.

= | Note: A maximum of 50 attributes is the limit for one table (visible main
node).

= | Note: Hovering over an attribute node will display the first 10 values of
that attribute in a tooltip.

The attributes newly added won’t be visible straight away. Open the context menu of the
main node by clicking it with the right mouse button and select add all attributes or
use the equivalent toolbar button or a specific attribute from the list (Add attribute). To
remove attributes for the purpose of clearness, select Remove attribute from the context
menu of the desired attribute node. Removing an attribute can also be done by dragging
it to its task node.
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+- Piping |_ add attribute > | Dry Weight |
+- Piping Cal 5= add all attribukes End Preparation [
End Standard
o Ngzzrhi Equiprment Marne |
+ Mozzld Mozzle Mame
* Mozzls Mozzle Place Point
: EEZEIE Mozzlz Place Point ¥
+ MNpd L Mozzle Place Point 7
+ Part Oy Npd
+ Part M
T Fress Mpd Unik Type
+ Cluant Part Descripkion
: gs:;: Part Mumber
Pressure Rating
Cuankity
uantity Unik Type
Schedule Thickness
|

Arranging Views

Arranging the views is the main purpose of 3D DataManager. In order to keep the proc-
ess simple, all actions can be done with a mouse. The following chapters will help set-
ting up each view part by part. All changes listed here are saved to a View file when
saving the View.

Filter and Grouping functionality

The Tree Filter can be used to filter and group the tree and so the report. For this pur-
pose the desired nodes may be nested. If you want, for example, see the different
Nominal Pipe Diameters in the tree that are used for a specific Pipe Run follow the
steps below:

1. Grab and drag the NPD node on the 2. Drop the node and expand the sub-
Pipe Run node. node.
Only the desired attribute nodes will be
shown.
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File  Tools  Wew  Help File  Tools  Wiew  Help
e iEEEE S Dm%] L EEE 85 %
Pipe Part B3 [ MewView E1' NewView(?] EJ Pipe Part Mewview E3 NewView(2) B3

+/- Heat Tracing Type +- Insulation Thickness ~
+- Industry Commodity Code +- NPD
+- Insulation Material +- Mpd 2
+- Insulation Purpose +- Npd Unit Type 1
+- Insulation Spec Name + Object Type
+- Insulation Temperature +|- Operating M aximum Preszsure
+- Insulation Thickness +- Operating Maximum Temperature
+- Interior Coating Reguirement +- Dperating Minimum Prezsure
+- Interior Coating Type +- Operating Minimum Temperature
+- Interior Surface Treatment Type = Pipe Run
+- ltem Mame S AL
+- Liming Material = 4P 0110003
+- Long Description 2. NPD
+ Material Grade 15.9 mm % 95.2 rm
- Moniker 15,9 mm % 95,3 mm
+- NPD 4in
#-Npd 1 % Distillation Urit BO01-1-P-0011-200032
; gz;je; _ - Distlation Uit BO1-1-P-0012-2C0032
41 Operating Max Temp + D!st!llat!on Lln!t BO1-1-P-001 7-1C0031
4 Operating Min Temp +- Digtillation Unit BOT-1-P-0018-1C0031
+ Part Number 1 Dishillabion Unit BO1-2-P-0003-2C0032
: +- Dighillation Unit BO1-2-P-0005-2C0022
o +- Dighillation Unit BOT-2-CR-0001-1C0031
e +- Dighillation Unit BOT-2-4/C5-0002-1C0031
i +- Dighllation Unit BO1-3-P-0001-2C0022
- +- Dighllation Unit BO1-3-P-0002-2C0022
Piping Catalog +- Digtillation Unit BO1-3-P-0004-2C0022
= +- Dighillabion Unit BOT-3-P-0013-1C0031 .
£ ¥

This process can be repeated recursively until the desired granularity has been reached.

Column-attributes configuration

For the currently selected node a report will be shown in the grid view of the Report

section like shown below.
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qon S0 DataManager Reporter - C:ADocuments and SettingsWidministratorADesktopiadison.mdb

File  Tools  ‘Window  Help
025 0% R i ]
HewView
= m ~ 2354 Records

+- Area System Area Spstem Commadity Type Date Last Modified  Design Maximum Design Maximum  Design Minimun #
+- Commodity Type
+- Date Last Modified » | Refining &rea 1/6/2007 11931 & 1
+- Design Maximum Press Refining Area 1642007 11931 A 1
+- Design Maximum Temp Fiefiing Area 1/65/2007 1:19:31 A 1
+- Design Minimum Press. Refining Area 1/6/2007 11931 A 1
+- Design Minimum Tempe Refining Area /642007 1:19:31 & 1
+- Dy Weight Refining Area /642007 11331 A 1
+- First Size Schedule Riefining Area 14642007 1:20: 21 &
4 Fluid Type Fefining Area 1/6/2007 1. 20:21 &
+- Industry Commodity Co Refining Area 14642007 1:20: 21 &
+- Ingulation Matenal Riefining Area 12642007 1:20: 21 &
+- Ingulation Purpose Fiefining Area 1/6/2007 1:20:21 &
+- Ingulation Thickness Fiefining drea 1/6/2007 1:20:21 &
+- NPD Fiefining Area 1/6/2007 1:20:43 A
= Npd 1 Fiefining Area 1/6/2007 1:20:43 4
+-Npd Unit Type 1 Fiefining Area 1/6/2007 1:20:43 A
+- Object Type Refining Area 1/6/2007 1:20:43 &
+- Operating Maximum Pre Fiefiring Area 1/6/2007 1:20:43 &,
+- Operating Maximum Te Fefining Area 1/6/2007 1:20:43 4
+- Operating Minimum Pre Refining Area 1642007 1:21:16 &
+- Operating Minimum Ter Riefining Area 14642007 1: 2116 &
+ Pipe Run Refining Area 17642007 12116 &
+- Pipe Run NPD b Rrfininn Area 1ARANNF 121 1R A L4

< » < L

L)

This report can be expanded and grouped through further attributes as mentioned in
chapter Filter and grouping functionality above. By default all available columns for the

currently selected node are shown. Click the E putton to show the attribute/column

configuration section and select the columns to add or remove.

v
00

v S0 DataManager Reporter - C:\ocuments and Settings\Widministrator\Desktopiadison.mdb

File  Tools  ‘Window  Help
22 5 0%k s w i EEE]
HewView
= m -~ g g 2354 Records
+- Area System 5[] Area System Area Spstem Commadity Type Date Last Modified  Design Maximum #
+- Commodity Type
+ Date Last Modified £ [¢] Commociiy Type Refining & 1/6/2007 11531 4
+- Design Maximum Press * Date Last Modiied Hef?n!ng A[ea 1/6/2007 1j19j31 A
+ Design Maximum Temp + Design Maximum Pressu Hef!n!ng Area 1/E/3007 1:19:31 A
% Design Minimum Presst % [¥] Design Mazimum Tempe Fcfiin Aro 1/6/2007 118,31 &
+- Design Minimum Tempe + Dezign Minimum Pressun Hef!n!ng '&lea 1/5/2007 1:19:31 &
+ Dry Weight £ [¥] Design Minimum Temper Hef?n!ng Alea 1/6/2007 11931 &
+- Firgt Size Schedule + Dt Hef!n!ng Area 1/6/2007 1:20:21 )
% Fluid Type & [v] First Size Schedule T 1/6/2007 1.20.21 &
1. Industry Commodity Con £ [v]Fluid Type Hef!n!ng A[ea 1/6/2007 1:20:21 &
#- Insulation Material - [] Inchustry Commocity Code Fiefiba Area 1/6/2007 1:20:21 &
£ Insulation Purpose + Inzulation Material Hef!n!ng Area T 1:20:21 i
+- Ingulation Thickness % LTt ST TR - !n!ng -
+ Inzulation Thickness Heﬂn!ng Area L6 20T o0 1l

+- NPD " = Refining Area 17672007 1:20:43 &
+- Npd 1 ) 5 Mpd 1 Refining Area 1/6/2007 1:20:43 &
" Object Type s (AN Lk Ty et e TR/ T 20434
+ Operating Maximum Pre # ] Object Type Ffiing Arec 1/6/2007 1:20:43 A
% Operating Maximum Te 8 [7] Dperating Maxim.m Pres Ficiring Ares 1/6/20071.2043 &
+- Operating Minimum Pre & [vl Operating Maximum Tem Hef!n!ng ﬁ[ea 1/6/2007 12116 &
+ Operating Minimum Ter + Operating Minimum Pres: He Ining Ares =

y + Operating Minimum Temg ef!n!ng iIEs i A ER
+- Pipe Run 5 Fine: Fiun Refining Area 1/6/2007 1:21:16 A
+- Pipe Run NPD hd P Riefininn drea 1AR/NN7 1-711R & A

£ > < > >
L)
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B
With the buttons on top of the Attribute section all items can be checked (“#°) or un-

checked (.6.).

Certain Attribute operations can be used, represented by the sub nodes in the Report
Attributes. Currently MIN, MAX, SUM and COUNT are implemented. When en-
abled, a column per enabled function shows the result.

=| Note: MIN, MAX and SUM are only available for numeric attributes.

= | Note: The order of columns shown in “Attributes Section” is alphabetical
and does not correspond to the order of columns shown in the grid. Add-
ing/Enabling one additional column will append the column at the end of the

grid.

Example:

Grid view without functions

+- Equipment

=- Piping

Area Spstem
Commodity Type

Date Last Modified
Design Maximum Press
Design Maximum Temp
Deszign Minimum Press
Design Minimum Temp:
Dry Weight

Firzt Size Schedule
Fluid Type

Industry Commodity Co
Inzulation M aterial
Inzulation Purpose
Insulation Thickness
NPD

Hpd 1

Mpd Unit Type 1
Object Type

Operating Maximum P
Operating Maximum Te
Operating Minimum Pre
Operating Minimum Ter

FPine Bun

< ?

T O Oy O O O O ] O O O O O oy

W

HI = |
P E O

#-[] Area System
+-[_] Cammodity Type
+-[] Date Last Modified
+-[] Design Maximum Pressu
- [] Design Masimum Tempe
+-[] Design Minimurm Pressur
+- [ Design Minimum Tempe
+ Diry Wfeight
+-[] First Size Schedule
[ Fluid Type
= Industry Commadity Cods
+- [ Insulation Material
+- [ Insulation Purpase
+-[] Insulation Thickness
2 C]HPD
5 [7]Mpd 1
+ Npd Unit Type 1
+ Ohject Type
+-[] Operating b aximum Pres
+- [ Operating M aximum Ter
+-[] Dperating Minirum Pres
+- [ Operating Minimum Tem
+- [ Pipe Run

< >

W

Obiject Type

anhection Suppo
Connection Suppo
Connection Suppa
Connection Suppo
Connection Suppo
Connection Suppa
Connection Suppo
Connection Suppa
Connection Suppo
Connection Suppo
Connection Suppa
Connection Suppo
Connection Suppa
Fipe Bolt Set

Pipe Bolt Set

Fipe Bolt Set

Fipe Bolt Set

Pipe Companent
Fipe Component

Pipe Component
| g AR o Fpepuppypeyen §

593 Records
Dy Wfeight Industry Carmmodit

3z
36

BAZZZZ A AYRE
BAZZZZZZMAYRE
BAZZZZ A AYBE
YEZZIHEZFFF
S0E33264D
2.7 FAAsHDCZZAAD
4.5 FAALHDCZZAAD

P e P Y Y

Mpd Unit Type 1

B

Grid view with SUM enabled for Dry Weight column
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Mpd Unit Type 1

)

Equipment A g g 178 Records

= Piping [ ] Area System 3 Obiject Type SUR_of_Dry'w'eig Industry Commodit
Area System |
Commodity Type [] Carnmadity Type -~
Date Last Modified T Tl T
Design Maximum Press [ Design Maimurn Pressu . :
Design Maximum Temp I CDnnBCt!DH aurs -
Design Minimum Press: I Eonnectfon ouppo =
Design Minimum Temp: [ Design Minimum Temper Eonnect!on o z
Dry Weight = [ 0w Weight e 2
First Size Schedule I e ,:me!m SUPPD EE
Fluid Type DMIN onnect?on Lppo X
Industry Commodity Co SUM Eonnec:!on guppo gg
Insulation Material L Eonnectfon Suppo 10.4
Insulation Purpoze TR Ll e '
Insulation Thickness BBl Fluid Typo Connect!on L6 28

Industry Commodity Cod Connection Suppo 8.8
NPD [ Insulation Material Connection Suppo 102
Npd1 ] Insulation Pur Pipe Balt Set BAZA7777AMYRE
. pose
Npd Unit Type 1 [ Insuistion Thickness Fipe Balt Get BAZZZZZZAMYRE
Object Type CINFD Pipe Baolt Set BAZZZZZZAMVBE
Operating Maximum P Npd 1 Pipe Bolt Set VZZZHZZFFF
I]pelat!ng M_a:flmum Te Mpd Urit Type 1 Pipe Component 90E39264D
Operating Minimum Pre fibiect Type Pipe Component 105 3| FassHDCZ2AA80
=0 ting Mini T 7
& Qoeraing Minman Ter | & (3000 P | Poe Conperen EL T
< » < > <

Grid customizing and filter functions

28

Within the grid, columns can be moved, sorted and filtered.

Sorting

Click the column header to sort the row ascending and once more in descending order.

Object Type

Fipe Part

Fipe Part

[+ | Fipe Part

Fipe Part

Fipe Part
Standard Support
Fipe Component
Fipe Component
Fipe Component
Fipe Component
Pipe Component
Standard Suppart
Fipe Component
Fipe Part

Fipe Component
Fipe Part
Standard Suppaort
Standard Suppart
Fipe Component
Fipe Component
Standard Suppart

| PSS o I Y

178 Records
SUM_of_Dy'w'e = Industyy Commodit | Mpd Unit Type 1
4 PAATAROZZARBA  |in
] Pt BOSA0BA iR
At ROAABA  din
AMTFROZZABA ik
Ot AROESABS  in
in
AdAHABAHADL  |in
MCMZZBOZZAME  |in
et AHDCZA2880  |in
AdAHABAHADL  |in
MCMZZBOZZAME  |in
] in
S MCMEZBOZZAAE  |in
PIFE1001420100 | rarr
WVaAAAHABAHAD  |in
PaAT~BOSZABA  |in
in
in
CMZZBOEEAME  in
WasAHABAHAD  |in

N o Ta el & /i A | LA M Al AT

Mpd 1 Schedule Thickr #

E.0/S-5TD
8.0/5-5TD
12.0/5-5TD
10.0/5-5TD
4.0/5-5TD
20
8.0/ Undefined
8.0/5-5TD
2.0/ Undefined
10.0| Undefined
12.0/5-5TD
a0
10.0/5-5TD
100.0/5-5TD
E.0| Undefined
A0/5-5TD
20
a0
E.0/5-5TD
12.0|Undefined
4.0

Lo B A I PP (R S |
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Reordering

Grab and drag the column you want to move and drop it to its new location (marked by
a red arrow).

178 Recaords Npd Unit Type 1
A_of_Drpwe | Industy Commodit | Mpd Uit Type 1 Mpd 'I‘rSI:heduIe Thicknes | Short Material Des |
2AEA1 . 2| PAAZFBOZZABS  |in E.0|5-5TD Pipe, 5-5TD, BE,
» 22399 BiPAASSBOSZABA  fin 8.0/S5TD Pipe, 5-5TD, BE,
214658 PAASBOZZABS  |in 12.0/5-5TD Fipe, 5-5TD, BE.
16384, 3| PAAZABOZZABA  |in 10.0/5-5TD Pipe, 5-5TD, BE,
11165.2| PAAZZBOZZABA  |in 40/5-5TD Pipe, 5-5TD, BE,
JEE2.0 in 20 Al 1/2 in Standa
2390, 2 VAAAHABAHAD]  |in 2.0| Undefired Gate vakve, CL1A0
1427 1| MCMEZBOZZ4AE  |in 3.0/5-5TD A0 deg LR elbow, |
1044 3 FAAAHDCZZAAD  |in 8.0/ Undefined Flange. CL150, RF
10320 VAAAHABAHAD]  |in 10.0| Undefined Gate vakve, CL1A0
1004, 4 MCMZZBOZZAAE  |in 12.0/5-5TD 90 deq LR elbow, [
9959.0 in an Arwil FIG295 3 in
W24 MCMEEBOEZAAE  |in 10.0(5-5TD A0 deg LR elbow, [
8907 PIPE1001420100 | rmm 100.0/5-5TD Pipe, 5-5TD, BE
7940 VAAAHABAHAD]  in E.0| Undefined Gate vakve, CL1A0
BEY. 4 PAbF BOZZ4BA  |in 3.0/5-5TD Fipe, 5-5TD, BE,
ERE.0 in 20 Arvil FIGT401/2 in
BEE.0 in a0 Al 1/2 in Standa
6213 MCMZZBOZZAAE  |in E.0|5-5TD 90 deq LR elbow, [
529 B VAAAHABAHAD]  |in 120/ Undefined Gate vakve, CL1A0
BRE.0 in 4.1 Anvil 1/2 in Standa 3
< ¥
Filtering
kIMN_of_Mpd 2
[ [+
Clear Filker A
MLILL
MOT-MILL
1
156
2
4 W
£ ¥

The NULL Value will filter for all empty values in the column, while the NOT-NULL
does the opposite.

It is also possible to filter by manually typing into the Filter field. Possible operators
while manually filtering include ‘<’,”>’,’<="">=""<>""*’ or "%’. It is also possible to

use the && (and) conjunction to place multiple filters for the same column.

= | Note: “*’ and ‘%’ can be used interchangeably, they can be used before
text, after text or both but not in text i.e.
Valid uses: S*, *S or *S*

Non-Valid use: S*S

29




CAXperts 3D DataManager Quick Reference Guide

= Note: Filters are not case sensitive, with the exception of NULL and
NOT-NULL. Thus is it possible to filter for the value null.

= | Note: One additional filter method is available only in 3D DataManager
Pro (see Previewing Changes).

Resizing

It is possible to resize each column in the Report Grid as seen below. There are two pos-
sibilities to do this.

178 Recordz

Ohbject Type SUM_of_Dry weight Industry Commodity Code MNpd Mpd | Schedule Thickr #

[+ iStandard Support Component 124 10.0}in
Pipe Compaonent 90E 332640 100 mm |5-5TD
Pipe Bolt Set BATTTT T YYBETZZS 15.9| mm
Fipe Bolt Set BASA A AYBETZZUS 19.1 | mm
Fipe Bolt Set BASSAATAMYBETZZUS 22,2 mm
Pipe Component 1063 | FAAAHD CZZAADABDES1S 2.0/in IIndefined
Pipe Compaonent 1395 |FAAAHDCAZAA8DARDES1S 300 |Jndefined
Pipe Compaonent A06.0|FAAAHDCZZAADABDES1S 4.0/in |Indefined
Pipe Compaonent 4287 |FAAAHDCZZAADABDES1 S B.0/in |Indefined
Pipe Companent 1044 3 FAAAHDCZAAADARLSZUS 3.0/ in |Indefined
Pipe Component 8192 | FAAAHD CZZAADABDESIS 10.0}in IIndefined
Pipe Compaonent 438 6| FAAAHDCAZAADARDES1S 12.00in |Indefined
Pipe Compaonent 328 FAAAMDCEZAADARBLZZUS 2.0/in |Indefined
Pipe Compaonent 136.0|FAsAMDCAZAADARDESIS 300 |Jndefined
Pipe Companent 226 FAAAMDCEAAADABLSZUS 4.0/ in |Indefined
Pipe Component 38,2 FASAMD CEEAMDARLEZLS E.0/in IIndefined
Pipe Compaonent FSO35B1504G 100, mm | Undefined
Fipe Gasket GMAHACAB=BEPUS 2.0/in
Fipe Gasket GMAaHACAB=BEPUS 3.0in
Fipe Gasket GMAHACAB=BEPUS 4.0/in
Fipe Gasket GMAHACAB=BEPUS B.0/in

4

The first possibility is to drag the space between columns to the right in order to in-
crease the size, and to the left in order to decrease the size. There is also the possibility

to auto size each column to the largest value. This is done by simply double clicking the
space between the columns.

Closing and Saving

Closing a view can be done by right clicking on the tab to open the context menu, then
selection the close view option (see View Context Menu), or by using the tool bar but-
ton (see toolbars).

If a View has been changed, or a View is newly created, a prompt will appear asking if
the view is to be saved before closing.

If a view is newly created, the Save As dialog will appear, if saved or closed. Also there
is the possibility to save all views at once. This option can be found under the file menu.
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5.3

Reporting

To export a report into an Excel spread sheet use the Toolbar button Export to Excel (“&).
The following dialog will appear.

X

Create Report

[] Usze a Template
Template file path
[ v| [ Fle. J[ New ][

Edit |

[ Create Report... ] [ Cancel ]

If you intend to use a template file, first press the File... or the new button to select an exist-
ing or create a new template. In case Use a template option has been checked, the current
item in the Template File Path combo box will be used to format the data while exporting.
It is recommended to create or edit a template using the New or Edit button which will in-
voke a Toolbar inside the excel application to help create and customize the current tem-
plate.

S=1E

E3 Microsoft Excel - templ1.xls

@_1 File Edit Wiew Insert Format Tools Data  Window  Help  Adobe PDF - 5 X
i [ o 10 B Z U|===538 %|=|i-5- A
LA - %
A | B [ ¢ | b [ E | F [ 6 [ H [ I F

Plant IT-Solutions

10 |Object Ty SUM_of [ Industry CHpd 1 Hpd Unit " Schedule Short Material Description
11 [#0bject Ty#SUM of #ndustry (#hlpd 1% | #hpd Unit #5chedule #5hort Material Description#

. CA ]erls

14 CAXperts Report Configurator v
W4 > MNReport {8 ke chandard Repart Add Column = Header Lines | 10 Skip Lines |0
Ready

The macro offers the following options/settings:
. Create Standard Report — Apply the Header and Skip Lines setting and
rebuild the sheet

« Add Column - Insert a column marker for the selected column in the cell
currently selected

. Header Lines — Insert the number of rows that should be between the
upper border and the column markers
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« Skip Lines Between Rows — Inserts the given number in empty rows be-
tween each line(s) with data

Additionally it is possible to insert pictures (i.e. your company logo), text and/or text for-
matting.

Other important functions include the Multiline reports. By simply spreading the column
marker across more than one line a multi lined repot is created.

Microsoft Excel - templl.xls E][E|E|

(2] Fle Edt iew Insert Format  Tools Data  Window  Help  Adobe PDF -8 X

EHEE.ﬁ.rial 10 - B I UIE=E=EH|S$ %|E(FH-0-A- K
H21 - =

A | B | ¢ | b | E | F | &6 [ H | 1=

Plant IT-Solutions

10 [Object Ty SUM of [ Industry Commodity Code Schedule Short Material Description
11 [#0bject Ty#=UM of #ndustry Commodity Code## #3chedule | #=hort Material Description#

. CA ]erls

12 Npd #lpd 1#  #lpd Unit Type 1#

13

14 CAXperts Report Configurator * W
M 4 F M ""-.\REICIDI‘t);.'f 3 Create Standard Report Add Column =~ Header Lines | 10 Skip Lines |0

Ready

It is also possible to create Multipage reports. This is achieved by placing one or more col-
umn marker with in the header area. Placing for example #Area System# from a piping re-
port in to the header area, will create one sheet for each different type of Area System.
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E3 Microsoft Excel - templ1.xls E_|E|E|
@_1 File Edit Miew Insert  Format  Tools Data  Window  Help  Adobe PDF -0 X
EHEEArial 10 -|B Z UEEE=H[S % EFEH-M-A- H
3 - b
A | B [ e | o [ E | F | 6 | H [ 13

1

2

: —

B

Flr S —

9 Object Ty#Cbject Typew Plant IT-Solutions

]

10 SUM _of [Industry Commodity Code Schedule Short Material Description

11 #3UM of #ndustry Commodity Code# #ochedule #5hort Material Description#

12 |Npd #lpd 1% #lpd Unit Type 1#

13

14 CAXperts Report Configurator v X
M 4 » WhReport/{ Create Standard Report Add Column + Header Lines | 10 Skip Lines |1

Ready

Close and save the template when you have finished. The Create Report dialog will be dis-
played again. Hit Create Report to generate the report.

E3 Microsoft Bxcel - Madison_2009-06-0%9 081003, xls

@ File Edit Miew Insert  Format  Tools Data  Window  Help  Adobe PDF -8 X
P A | B s UulS=S=-08 n]E|E 50 A- M
=R ORI o = A
Picture 1 - i
A | = | C |D| E| F =

7

8 [Ohject Type Pipe Component F|i||1”l'5|l|llﬂﬂﬂ5

g

10 S5UM o Dy Weight  Industry Commodity Code Schedule Thick
11 S0E39264D S-5TD

12 |Npd 100 mm |

13

14 105.3 FAALHDCIZAADABLLIS Undefined

15 |Npd 2in |

16

17 139 5 FAAAHDCIZAADABQIIUS Undefined

18 |Npd 3in | -
1

M 4« » w\ Report 4 Report (2) Y% Report (3) 4 Report (4) £ | < el
Ready

Above is the finished report with multiple Sheets. In this case each sheet represents a differ-
ent object type.
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5.4  Example

Creating Report Pipe list per Unit System

1. Grab and drag the Unit System node and drop it on the Area System node.

File  Toaols  ‘Window  Help

L F @ e E

HewYiew

+ Equipment A
+ Info
= Piping

* ku!lgln
Fipe ':’:?'u

Short Code
Spec Name
Unit System

xR AR

2. Expand the Area System nodes and select the desired Unit System.

¥ Equipment -
= Piping
-I- Area System
+- AL
= Sulphur Recoven Area
= Unit System
Injection Package 1
Injection Package 2
Injection Package 3
tain Pipe Rack
Maduledzzembly-001
Recover Stage 1
Recover Stage 2
=1 LItility Area
= Unit Syztem
Distillation Uit
tain Fipe Rack
Recovery Uit
Steam Generation Unit
Commodity Type
Date Last Modified
Dezign Maximum Pressure

Dezign Maximum Temperature
Dezign Mimmum Pressure
Dezsign Mimimum Temperature
Dry Weight

Firgt 5ize Schedule

Fluid Type

o Oy O oy B g
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3. Select the Attributes that should appear on the report (Pipe Run, Pipe Run NPD).

B o
B o |

Area Spsfan ”
Lo Sieefan

[ ] Commodity Type

[]Date Last Modified

[] Cesign b asimum Pressure

[] Cesign kasimum Temperature
[] Cesign inimum Preszure

[] Cesign Minimum Temperature

[ ] Ciry wieight

[ ] First Size Schedule

[] Fluid Type

[ ] Industry Commodity Code

[ ] Inzulation b aterial

[]Inzulation Purposze

[ ]Inzulation Thickness

[ JWPD

[Mpd 2

[ ]Mpd Unit Tupe 1

[] Object Type

[] Operating b aximum Pressure
[] Operating b asimum Temperature
[] Operating Minimum Pressure

[] Operating Minimum Temperature
Fipe Run

Fipe Run MPD

Fipe Fun MFD Unit Type

[ Pipeline System v

O O oy Oy O O O ] O O O O O Oy O Y Oy O Y O O O O Y Y

£
W
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36

4. Report preview in the Grid

Araa Sypafam
Sulphur Recovery

[+ | Sulphur Becowvery

Lhrmit Speafaiy
Recovemn Stage 1

Recovern Stage 1

22 Filtered Records from a Tatal af 151
Pipe Run

P-176-10"1C0031
P-176-2"-1C0031-
P-176-8"-1C0031-
P-177-10"1C0031
P-177-2"1C0031-
S-172-12"1C0031
S-172-2"1C0031-
5-172-4"1C0031-
5-172-6"1C0031-
5-172-8"1C0031-
5-174-2"1C0031-
5-174-4"1C0031-
5-174-6"1C0031-
5-174-8"1C0031-
5-175-8"1C0031-
5-187-2"1C0031-
SC-156-1-1/2"1C
SC-156-3"-1C0031
SC-156-6"-1C0031
SC-168-1"1C0031
SC-168-2"1C0031
SC-168-3"-1C0031

Pipe Run HPD' Pipe Run MPD Uit

10/in
2/in
alin
10/in
2/in
12/in
2/in
4/in
Elin
alin
2/in
4/in
Elin
alin
alin
2/in
1.5/in
3lin
Elin
1lin
2/in
3lin

5. Save the View

File | Toals  Yiew  Help
L= (Openproject... Ale4C o= 7= ﬂ@
j Cpen Migw, ..
o Mew Yiew ~l e o
— - ‘@ O
|_d Save Wiew | [V Area Spstam
5 Save View As... Lt Speatany
Save Al Yiews. .. #)- [] Commedity T-"'FTE.
+- [ Date Last Modified
#4  Close Yiew +- [ Design Masimum Pressure
+- [ Design Masimum Temperature
Recent Projects » +- [ Design Minimum Pressure
] +- [ Design Minimurm Temperature
EXIt ||:'||t+Q 1 + D Dr}' "\-'-.-"Elght
TrTOTE=, =T . .
Ep— ':'ra|:|1 +- [ | First Size Schedule
1ECOvEN alage i
=T +- [ Fluid Type
HECD‘\:"E[}I Stagez 8 | I Y U RO WO o JERPRRVUN 1 U o B PN

6. Export the report to Excel using a custom template or the default template
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A | B C | D | E

_ 5 |Area System Unit System Pipe Run Fipe Run NFPD |Fipe Run NPD Unit Type
_ B |Sulphur Recovery Area Recovery Stage 1 | P-176-10"-1C0031- 101in
_ 7 |Sulphur Recovery Area  Recovery Stage 1 | P-176-2"-1C0031- 2lin
_ 8 |Sulphur Recovery Area Recowvery Stage 1 | P-176-8"-1C0031- lin
9 |Sulphur Recovery Area Recovery Stage 1 P-177-10"-1C0031- 10/in
10 | Sulphur Recovery Area  Recovery Stage 1 P-177-2"-1C0031- 2lin
11 |Sulphur Recovery Area |Recowvery Stage 1 |5-172-12"1C0031- 12/1n
12 |Sulphur Fecovery Area Fecovery Stage 1 |5-172-2"-1C0031- 2lin
13 |Sulphur Recovery Area  Recovery Stage 1 |3-172-4"-1C0031- 4lin
14 |Sulphur Recovery Area  Recovery Stage 1| 5-172-6"-1C0031- Blin
15 |Sulphur Recovery Area  Recovery Stage 1| 3-172-8"-1C0031- lin
16 |Sulphur Recovery Area Recovery Stage 1| 3-174-2"-1C0031- 2lin

17 |Sulphur Recovery Area Recowery Stage 1 5-174-4"-1C0031- 4lin

This Report is created using the default template.
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6 3D DataManager Pro
6.1 Grid Color Coding

In order to show the different states of each value in the Report Grid, The cells of the
grid are now color coded there are three colors as seen below:

33 Records

ition End Standard Equipment Mame  Mozzle Mame Hpd Mpd it #

AC-100

ALC-200

G-2
flange | Default B-0049 Copy of Piping Sk 4.0/n
flange | Default B-0049 Copy of Piping Sk 4.0/n
flange | Default B-0049 Copy of Piping Sk 2.0/n
flange | Default B-0049 Copy of Piping Sk 2.0/n
flange | Default B-0049 M1 4.0/n
flange | Default B-0049 M2 4.0/n
flange | Default B-0049 M3 4.0/n
flange | Default B-0049 M4 4.0/n
flange | Default 0100 M1 2.0/n
flange | Default 0100 H10 2.0/n
flange | Default 0100 M2 10.0 in

[ flange Default 0100 M3 2.0/n
flange | Default 0100 M4 B.0/in
flange | Default 0100 L 10.0 in
flange | Default 0100 HE 4.0/n
flange | Default 0100 M7 B.0/in
flange | Default 0100 Ha 2.0/n
flange | Default 0100 Ha 2.0/n 3
< >

Blue represents a cell that has had its value changed. Grey cells are cells that cannot be
edited, due to user rights, or belonging to read only values in SmartPlant 3D. White col-
ored cells represent unmodified changeable values.

6.2 Changing a Value

Editing a Value in the Grid is done very quickly with either the dropdown box (as seen
below) or via direct input. A dropdown box will only appear if the cell is code listed.
Columns that are code listed can only be changed using the dropdown.
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6.3

6.4

M9 Records

iticr End Standard Equipment Mame | Mozzle Mame MWpd MNpd it #

AC-100

AC-200

G-2
flange | Default B-0049 Copy of Fiping Str 4.0 in
flange | Default B-0049 Copy of Fiping Str 4.0 in
flange | Default B-0049 Copy of Fiping Str 200n
flange | Default B-0049 Copy of Fiping Str 200n
flange | Default B-0049 M1 4.0 in
flange | Default B-0049 e 4.0 in
flange | Default B-0049 M3 4.0 in
flange | Default B-0049 4 4.0 in
flange | Default D100 M1 3.0in

I» flange  Default w (M0 20in
flange |Default B i L L S 1 Y] 10.00 in
flange  Defaul LS N3 8.0 in
flange  Defaul LSULE N4 E.0 in
flange  Defaul G NG 10.0 in
flange | Default MHE 4.0 in
flange  Defaul L N7 E.0 in
flange  Defaul = IRE 8.0 in
flange | Default P, 3 M3 200n 3
< >
Reset Changes

In order to undo all changes from the Access Database all at once, the Reset Changes
function is available. This option can be found in the context menu of the grid.

1 Filter by Selection

Exclude Seleckion

| Clear All Filkers

Reset Yalues 3 all

By selecting this option, all changes made to the current task will be undone.

Previewing Changes

Additional features that 3D DataManager Pro offers are its preview columns. After
changing a value, the Old Value Column will appear in front of the changed column.
After writing changes to SmartPlant, the Update Status Column is added behind every
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column that has been updated. As seen below, two different operators are visible, the
Old Value and the Update Status Operators.

The Old Value operator shows the original value of a changed Attribute next to the new
attribute value. This is to ensure that prior to writing changes to SmartPlant 3D, it is
known which changes have been made.

|Ipdate Status |

319 Records

Old Value_of_Egqui Eguipment Name | Update Status_of_  Old Value_of_MNoz  Nozzle Name

w301 w301 Copy of Copy of C | Copy of Copy of C

w301 w301 Copy of Copy of C | Copy of Copy of C

w301 w301 Copy of Copy of C | Copy of Copy of C

w301 w301 Copy of Copy of C | Copy of Copy of C

w302 w-302a QK Copy of A Copy of A

w302 w-302a QK Copy of B1 Copy of C2 Up to date

w302 w-302a QK Copy of B2 Copy of B2

w302 w-302a QK Copy of C Copy of C

w302 w-302a QK Copy of D Copy of D

w302 w-302a QK Copy of E1 Copy of E1

w302 w-302a QK Copy of E2 Copy of E2

w303 w305 Up to date Copy of Copy of C | Copy of Copy of C

w303 w305 Up to date Copy of Copy of C | Copy of Copy of C

w303 w305 Up to date Copy of Copy of C | Copy of Copy of C

w303 w305 Up to date Copy of Copy of C | Copy of Copy of C
(b w303 Wwi-305 ilUp to date i Copy of Copy of C |Copy of Copy of C

w303 w305 Up to date Copy of Copy of C | Copy of Copy of C

w303 w305 Up to date Copy of Copy of C | Copy of Copy of C

W31 w311 Copy of Copy of & | Copy of Copy of &

W31 w311 Copy of Copy of B | Copy of Copy of B

W31 w311 Copy of Copy of B | Copy of Copy of B

_ WL Tl 211 R P U i v o {rurnr o

The other additional operator that is introduced in 3D DataManager Pro is the Update
Status. The Update Status displays one of four Values after the changes have been
written. The first of the possible shown values for this column is OK. This simply
means that all changes have been recorded with out a problem. The second possibility is
“Up to Date”. This states that the value that has been changed in the Report Grid has the
same value as the SmartPlant 3D object. The third possibility is an error message. This
means that the value cannot be written to the SmartPlant 3D databank. Amongst other
things, this can be due to user rights or database problems. The last of possible values is
blank. This means no action has been taken.

These columns can be added and removed where applicable, by checking the reflective
operator in the Report Attributes Tree.

An additional filtering method is also available in 3D DataManager Pro. The Changed
Values filter. When used, the filter shows only values that have been changed, making
previewing prior to writing to SmartPlant easier and more comfortable. This filter is
only available on two conditions. First, the column has to have had changes done to it,
and secondly, The Old Values Column has to be visible. If either of these conditions is
not met, the Changed Values filter will have no effect.
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6.5

Writing Changes

Tools | Window  Help

Tree Managet...

| Write Changes to SmartPlant 30... |

Settings. ..

Upon the selection of this option, the progress bar at the bottom right of the window
will show the status of this process. Once this process is complete a message box will
appear, stating the required time needed, and asking if the created database should be
opened.

All changes made in 3D DataManager Pro will also be changed in SmartPlant 3D. On
top of that, the Update Status Operation will be available and checked for each column
which had changes. This column shows the status of the update (see Previewing Chang-
es). After updating and depending on necessity, it may be necessary to export a new ac-
cess databank from SmartPlant 3D with 3D DataManager Extractor.

= | Note: The Write Changes Command processes each task separately. E.g.
if the current selected task is piping, only the changes made in piping will be
applied,

= | Note: In order to write changes, 3D DataManager needs to be executed
on a computer with SmartPlant 3D installed.
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